
ASUS Gaming Desktop PC
ROG CG8890
User Manual



�

En
gl

is
hEnglish En

gl
is

hEnglish

Copyright © 2012 ASUSTeK Computer Inc. All Rights Reserved.
No part of this manual, including the products and software described in it, may be reproduced, 
transmitted, transcribed, stored in a retrieval system, or translated into any language in any form or by any 
means, except documentation kept by the purchaser for backup purposes, without the express written 
permission of ASUSTeK Computer Inc. (“ASUS”).
Product warranty or service will not be extended if: (1) the product is repaired, modified or altered, unless 
such repair, modification of alteration is authorized in writing by ASUS; or (2) the serial number of the 
product is defaced or missing.
ASUS PROVIDES THIS MANUAL “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OR CONDITIONS OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL ASUS, ITS 
DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE FOR ANY INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF PROFITS, 
LOSS OF BUSINESS, LOSS OF USE OR DATA, INTERRUPTION OF BUSINESS AND THE LIKE), 
EVEN IF ASUS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES ARISING FROM ANY 
DEFECT OR ERROR IN THIS MANUAL OR PRODUCT.
SPECIFICATIONS AND INFORMATION CONTAINED IN THIS MANUAL ARE FURNISHED FOR 
INFORMATIONAL USE ONLY, AND ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE, 
AND SHOULD NOT BE CONSTRUED AS A COMMITMENT BY ASUS. ASUS ASSUMES NO 
RESPONSIBILITY OR LIABILITY FOR ANY ERRORS OR INACCURACIES THAT MAY APPEAR IN THIS 
MANUAL, INCLUDING THE PRODUCTS AND SOFTWARE DESCRIBED IN IT.
Products and corporate names appearing in this manual may or may not be registered trademarks or 
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Notices	
REACH
Complying with the REACH (Registration, Evaluation, Authorisation, and Restriction of 
Chemicals) regulatory framework, we published the chemical substances in our products at 
ASUS REACH website at http://csr.asus.com/english/REACH.htm.

Federal Communications Commission Statement
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions:
•	 This device may not cause harmful interference; and
•	 This device must accept any interference received including interference that may cause 

undesired operation.
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with manufacturer’s instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that interference will not occur 
in a particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures:
•	 Reorient or relocate the receiving antenna.
•	 Increase the separation between the equipment and receiver.
•	 Connect the equipment to an outlet on a circuit different from that to which the receiver is 

connected.
•	 Consult the dealer or an experienced radio/TV technician for help.

The use of shielded cables for connection of the monitor to the graphics card is required 
to assure compliance with FCC regulations. Changes or modifications to this unit not 
expressly approved by the party responsible for compliance could void the user’s authority 
to operate this equipment.

http://csr.asus.com/english/REACH.htm
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RF exposure warning
This equipment must be installed and operated in accordance with provided instructions and 
the antenna(s) used for this transmitter must be installed to provide a separation distance of 
at least 20 cm from all persons and must not be co-located or operating in conjunction with 
any other antenna or transmitter. End-users and installers must be provide with antenna  
installation instructions and transmitter operating conditions for satisfying RF exposure 
compliance.

Canadian Department of Communications Statement
This digital apparatus does not exceed the Class B limits for radio noise emissions from 
digital apparatus set out in the Radio Interference Regulations of the Canadian Department of  
Communications.
This class B digital apparatus complies with Canadian ICES-003.

Macrovision Corporation Product Notice
This product incorporates copyright protection technology that is protected by method 
claims of certain U.S. patents and other intellectual property rights owned by Macrovision 
Corporation and other rights owners. Use of this copyright protection technology must be 
authorized by Macrovision Corporation, and is intended for home and other limited viewing 
uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering 
or disassembly is prohibited. 

Lithium-Ion Battery Warning
 
CAUTION: Danger of explosion if battery is incorrectly replaced. Replace only with the 
same or equivalent type recommended by the manufacturer. Dispose of used batteries 
according to the manufacturer’s instructions.

ASUS Recycling/Takeback Services
ASUS recycling and takeback programs come from our commitment to the highest standards 
for protecting our environment. We believe in providing solutions for you to be able to 
responsibly recycle our products, batteries, other components as well as the packaging 
materials. Please go to http://csr.asus.com/english/Takeback.htm for the detailed recycling 
information in different regions.

http://csr.asus.com/english/Takeback.htm
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Safety information

Disconnect the AC power and peripherals before cleaning. Wipe the Desktop PC using a 
clean cellulose sponge or chamois cloth dampened with solution of nonabrasive detergent 
and a few drops of warm water then remove any extra moisture with a dry cloth.

•	 DO NOT place on uneven or unstable work surfaces. Seek servicing if the casing has 
been damaged.

•	 DO NOT expose to dirty or dusty environments. DO NOT operate during a gas leak.
•	 DO NOT place or drop objects on top and do not shove any foreign objects into the 

Desktop PC.
•	 DO NOT expose to strong magnetic or electrical fields.
•	 DO NOT expose to or use near liquids, rain, or moisture. DO NOT use the modem during 

electrical storms.
•	 Battery safety warning: DO NOT throw the battery in fire. DO NOT short circuit the 

contacts. DO NOT disassemble the battery.
•	 Use this product in environments with ambient temperatures between 0˚C (32̊F)and 

35˚C (95̊F).
•	 DO NOT cover the vents on the Desktop PC to prevent the system from getting 

overheated.
•	 DO NOT use damaged power cords, accessories, or other peripherals.
•	 To prevent electrical shock hazard, disconnect the power cable from the electrical outlet 

before relocating the system.
•	 Seek professional assistance before using an adapter or extension cord. These devices 

could interrupt the grounding circuit.
•	 Ensure that your power supply is set to the correct voltage in your area. If you are not 

sure about the voltage of the electrical outlet you are using, contact your local power 
company.

•	 If the power supply is broken, do not try to fix it by yourself. Contact a qualified service 
technician or your retailer.
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Conventions used in this guide
To ensure that you perform certain tasks properly, take note of the following symbols used 
throughout this manual.

Where to find more information
Refer to the following sources for additional information and for product and software 
updates.
	 ASUS websites
	 The ASUS website provides updated information on ASUS hardware and software 

products. Refer to the ASUS website www.asus.com.
	 ASUS Local Technical Support
	 Visit ASUS website at http://support.asus.com/contact for the contact information of 

local Technical Support Engineer. 

DANGER/WARNING:  Information to prevent injury to yourself when completing 
a task. 

CAUTION: Information to prevent damage to the components when completing a 
task. 

NOTE: Tips and additional information to help you complete a task.

IMPORTANT: Instructions that you MUST follow to complete a task.

http://www.asus.com
http://support.asus.com/contact
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ASUS ROG Gaming 
Desktop PC

ASUS ROG U9N Gaming 
Keyboard package x1

ASUS GX900 Gaming 
Mouse x1

Installation Guide

Power cord x1 Nero 9 burning software DVD 
x1

Installation Guide x1

Warranty card x1 Support DVD x1 Recovery DVD x1 
(optional)

OR

Wi-Fi Ring moving antenna x2 
(optional)

Antenna x1 (optional)

Package contents

•	 If any of the above items is damaged or missing, contact  your retailer.

•	 The illustrated items above are for reference only. Actual product specifications may vary 
with different models.

•	 For details on using the bundled gaming keyboard and mouse, refer to sections Using 
the ASUS ROG Gaming Keyboard and Using the ASUS GX900 Gaming Mouse.
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Chapter 1
Getting started

Getting to know your computer

Front panel

Illustrations are for reference only. The ports and their locations, and the chassis color vary 
with different models.

Welcome!
Thank you for purchasing the ASUS ROG CG8890 Gaming Desktop PC! 
The ASUS ROG CG8890 Gaming Desktop PC provides cutting-edge performance, 
uncompromised reliability, and user-centric utilities. All these values are encapsulated in a 
stunningly futuristic and stylish system casing.

Read the ASUS Warranty Card before setting up your ASUS Desktop PC.

1

2

3

4

5

7
8

109 11 12

6
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1.	 Power button. Press this button to turn on your computer.
2.	 Secure Digital™ / MultiMediaCard slot. Insert a Secure Digital™ card or 

MultiMediaCard into this slot. 
3.	 Optical disk drive bay. There is an optical disk drive in this bay. 
4.	 Hot Swap Bay (empty). Allows you to install an additional HDD in this bay.  
5.	 Power LED. This LED lights up when you turn on your computer.
6.	 Memory Stick™ / Memory Stick Pro™ card slot. Insert a Memory Stick™ / Memory 

Stick Pro™ card into this slot.
7.	 CompactFlash® / Microdrive™ card slot. Insert a CompactFlash®  / Microdrive™ card 

into this slot.
8.	 OC Button. This button adjusts the System Level Up profile of your computer.
9.	 USB 3.0 ports. These Universal Serial Bus 3.0 (USB 3.0) ports connect to USB 3.0 

devices such as a mouse, printer, scanner, camera, PDA, and others.

•	 DO NOT connect a keyboard / mouse to any USB 3.0 port when installing Windows® 
operating system.

•	 Due to USB 3.0 controller limitation, USB 3.0 devices can only be used under Windows® 
OS environment and after the USB 3.0 driver installation.

•	 USB 3.0 devices can only be used as data storage only.

•	 We strongly recommend that you connect USB 3.0 devices to USB 3.0 ports for faster 
and better performance for your USB 3.0 devices.

10.	 USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0 
devices such as a mouse, printer, scanner, camera, PDA, and others.

11.	 Microphone port. This port connects to a microphone.
12.  	 Headphone port. This port connects to a headphone or speaker. 
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E-SATA

Rear panel

2120

1312

10 119

14

22

1.	���������������   USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0 
devices such as a mouse, printer, scanner, camera, PDA, and others.

2.	 Clear CMOS switch. Press the Clear CMOS switch to clear BIOS setup information 
only when the system hangs due to overclocking.

3.	 Optical S/PDIF_OUT port. This port connects to an external audio output device via 
an optical S/PDIF cable. 

4.	 ROG Connect switch. Allows you to monitor and adjust the local PC through your 
remote PC.

5.	 USB 2.0 ports. These Universal Serial Bus 2.0 (USB 2.0) ports connect to USB 2.0 
devices such as a mouse, printer, scanner, camera, PDA, and others.

6.	 USB 3.0 ports, support ASUS USB 3.0 Boost UASP Mode. These Universal Serial 
Bus 3.0 (USB 3.0) ports connect to USB 3.0 devices such as a mouse, printer, 
scanner, camera, PDA, and others.

3

6
4
5
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•	 The USB 3.0 ports only support Windows® 7 or later versions. UASP standard only 
supports Windows® 8.

•	 DO NOT connect a keyboard / mouse to any USB 3.0 port when installing Windows® 
operating system.

•	 Due to USB 3.0 controller limitation, USB 3.0 devices can only be used under Windows® 
OS environment and after the USB 3.0 driver installation.

•	 USB 3.0 devices can only be used as data storage only.

•	 We strongly recommend that you connect USB 3.0 devices to USB 3.0 ports for faster 
and better performance for your USB 3.0 devices.

7.	����������������������   External SATA ports. These external SATA ports connects to SATA storage devices.
8.	 USB 3.0 ports, support ASUS USB 3.0 Boost UASP Mode. These Universal Serial 

Bus 3.0 (USB 3.0) ports connect to USB 3.0 devices such as a mouse, printer, 
scanner, camera, PDA, and others.

9.	 Side Speaker Out port (gray). This port connects to the side speakers in an 8-channel 
audio configuration.

10.	�������������������������������     Rear Speaker Out port (black). This port connects to the rear speakers in a 4, 6, and 
8-channel audio configuration.

11.	 Center/Subwoofer port (orange). This port connects to the center/subwoofer 
speakers.

12.	������������������������   Microphone port (pink). This port connects to a microphone. 
13.	����������������������    Line Out port (lime). This port connects to a headphone or speaker. In a 4, 6, or  

8-channel configuration, the function of this port becomes Front Speaker Out.
14.	���������������������������     Line In port (light blue). This port connects to a tape, CD, DVD player, or other audio 

sources.

Refer to the audio configuration table below for the function of the audio ports in a 2, 4, 6, 
or 8-channel configuration.

	 Audio 2, 4, 6, or 8-channel configuration

Port Headset 
2-channel 4-channel 6-channel 8-channel

Light Blue Line In Line In Line In Line In
Lime Line Out Front Speaker Out Front Speaker Out Front Speaker Out
Pink Mic In Mic In Mic In Mic In

Orange – – Center/Subwoofer Center/Subwoofer
Black – Rear Speaker Out Rear Speaker Out Rear Speaker Out
Gray – – – Side Speaker Out
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15.	 PS/2 Keyboard / Mouse combo port. This port is for a PS/2 keyboard or mouse.
16.	�������  ����������� LAN (RJ-45) port. This port allows Gigabit connection to a Local Area Network (LAN) 

through a network hub.

Activity/Link LED Speed LED
Status Description Status Description
OFF No link OFF 10Mbps connection
ORANGE Linked ORANGE 100Mbps connection
BLINKING Data activity GREEN 1Gbps connection LAN port

SPEED 
LED

ACT/LINK 
LED

LAN port LED indications

17.	������������������������   Expansion slot bracket. Remove the expansion slot bracket when installing an 
expansion card.21.�

18.	 Sound card ports (removable). These ports connect to your output devices such as 
microphone, headset and speakers. 

19.	�������������������������������    ASUS Graphics Card (optional). The display output ports on this optional ASUS 
Graphics Card may vary with different models.

20.	 Power switch. Switch to turn ON/OFF the power supply to your computer.
21. 	 Power connector (input rated: 100~120/200~240Vac, 60/50Hz, 10/5A). Plug the 

power cord to this connector.
22 .	 Air vents. These vents allow air ventilation. 
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Setting up your computer
This section guides you through connecting the main hardware devices, such as the external 
monitor, keyboard, mouse, and power cord, to your computer.

Connecting an external monitor
Using the ASUS Graphics Card (on selected models only)
Connect your monitor to the display output port on the discrete ASUS Graphics Card.

To connect an external monitor using the ASUS Graphics Card:

1.	 Connect a monitor to a display output port on the ASUS Graphics Card.
2.	 Plug the monitor to a power source.

The display output ports on the ASUS Graphics Card may vary with different models.

•	 If your computer comes with an ASUS Graphics Card, the graphics card is set as the 
primary display device in the BIOS. Hence, connect your monitor to a display output port 
on the graphics card.

•	 To connect multiple external monitors to your computer, refer to Connecting multiple 
external monitors in Chapter 3 of this user manual for details.

E-SATA
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Connecting a USB keyboard and a USB mouse
Connect a USB keyboard and a USB mouse to the USB ports on the rear panel of your 
computer.

Connecting the power cord
Connect one end of the power cord to the power connector on the rear panel of your 
computer and the other end to a power source.

E-SATA

The pre-installed setup utility for the bundled ASUS GX900 Gaming Mouse can be 
accessed only when connecting the mouse to your computer before starting Windows® 
7 for the first time. Otherwise, you will have to manually install the setup utility from the 
bundled Support DVD. Refer to section Using the ASUS GX900 Gaming Mouse of 
Chapter 4 for details.

E-SATA
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Turning your computer ON/OFF
This section describes how to turn on/off your computer after setting up your computer.

Turning your computer ON
To turn your computer ON:
1.	 Turn your monitor ON.
2.	 Turn the power switch ON, then press the power button on your computer.

Turning your computer OFF
To turn your computer OFF:

1.	 Close all running applications.

2.	 Click  on the Windows® desktop.

3.	 Click  to shut down the operating system.

3.	 Wait until the operating system loads automatically.

Power button

E-SATA
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Chapter 2
Using Windows® 7

Starting for the first time
When you start your computer for the first time, a series of screens appear to guide you in 
configuring the basic settings of your Windows® 7 operating system.

To start for the first time:

1.	 Turn your computer on. Wait for a few minutes until the Set Up Windows screen 
appears.

2.	 From dropdown list, select your language, then click Next.
3.	 From the dropdown lists, select your Country or region, Time and currency, and 

Keyboard layout, then click Next.
4.	 Key in uniques names for the user name and computer name, then click Next.
5.	 Key in the necessary information to set up your password, then click Next. You may 

also click Next to skip this step without entering any information.

6.	 Carefully read the license terms. Tick I accept the license terms and click Next.
7.	 Select Use recommended settings or Install important updates only to set up the 

security settings for your computer. To skip this step, select Ask me later.
8.	 Review your date and time settings. Click Next. The system loads the new settings and   

restarts. You may now start using your computer.

If you want to set up a password for your account later, refer to the section Setting up a 
user account and password in this chapter.
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Using Windows® 7 desktop

Using the Start menu
The Start menu gives you access to programs, utilities, and other useful items on your 
computer. It also provides you with more information about Windows 7 through its Help and 
Support feature.

Launching items from the Start menu
To launch items from the Start menu:

1.	 From the Windows® taskbar, click the Start icon .
2.	 From the Start menu, select the item that you want to launch.

You may pin programs that you want constantly displayed on the Start menu. For more 
details, refer to the section Pinning programs on the Start menu or taskbar on this 
chapter.

Click the Start icon  > Help and Support to obtain more information about Windows® 7.

Using the Getting Started item
The Getting Started item on the Start menu contains information about some basic tasks 
such as personalizing Windows®, adding new users, and transferring files to help you to 
familiarize yourself with using Windows® 7.

To use the Getting Started item:

1.	 From the Windows® taskbar, click the Start icon  to launch the Start menu.
2.	 Select Getting Started. The list of available tasks appears.
3.	 Select the task that you want to do.

Using the taskbar
The taskbar allows you to launch and manage programs or items installed on your computer.

Launching a program from the taskbar
To launch a program from the taskbar:

•	 From the Windows® taskbar, click an icon to launch it. Click the icon again to hide the 
program.

You may pin programs that you want constantly displayed on the taskbar. For more details, 
refer to the section Pinning programs on the Start menu or taskbar on this chapter.
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Pinning items on the jumplists
When you right-click an icon on the taskbar, a jumplist launches to provide you with quick-
access to the program’s or item’s related links.You may pin items on the jumplist such as 
favorite websites, often-visited folders or drives, or recently played media files.

To pin items to the jumplist:

1.	 From the taskbar, right-click an icon.
2.	 From the jumplist, right-click the item that you want to pin, then select Pin to this list.

Unpinning items from the jumplist
To unpin items from the jumplist:

1.	 From the taskbar, right-click an icon.
2.	 From the jumplist, right-click the item that you want to remove from the jumplist, then 

select Unpin from this list.

Pinning programs on the Start menu or taskbar
To pin programs on the Start menu or taskbar:

1.	 From the Windows® taskbar, click the Start icon  to launch the Start menu.
2.	 Right-click the item that you want to pin on the Start menu or taskbar.
3.	 Select Pin to Taskbar or Pin to Start menu.

You may also right-click on the icon of a running program on the taskbar, then select Pin 
this program to taskbar.

Unpinning programs from the Start menu
To unpin programs from the Start menu:

1.	 From the Windows® taskbar, click the Start icon  to launch the Start menu.
2.	 From the Start menu, right-click the program that you want to unpin, then select 

Remove from this list.

Unpinning programs from the taskbar
To unpin programs from the taskbar:

1.	 From the taskbar, right-click the program that you want to remove from the taskbar, 
then select Unpin this program from taskbar.
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Using the notification area
By default, the notification area shows these three icons:

Action Center notification

Click this icon to display all the alert messages/notifications and launch the Windows® 
Action Center.

Network connection

This icon displays the connection status and signal strength of the wired or wireless network 
connection.

Volume

Click this icon to adjust the volume.

Displaying an alert notification
To display an alert notification:

•	 Click the Notification icon , then click the message to open it.

For more details, refer to the section Using Windows® Action Center in this chapter.

Customizing icons and notifications
You may choose to display or hide the icons and notifications on the taskbar or on the 
notification area.

To customize icons and notifications:

1.	 From the notification area, click on the arrow icon .
2.	 Click Customize.
3.	 From the dropdown list, select the behaviors for the icons or items that you want to 

customize.

Managing your files and folders
Using Windows® Explorer
Windows® Explorer allows you to view, manage, and organize your files and folders.

Launching Windows® Explorer
To launch Windows Explorer:

1.	 From the Windows® taskbar, click the Start icon  to launch the Start menu.
2.	 Click Computer to launch Windows Explorer.
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Exploring files and folders
To explore files and folders:

1.	 Launch Windows® Explorer.
2.	 From the navigation or view pane, browse for the location of your data.
3.	 From the breadcrumb bar, click the arrow to display the contents of the drive or folder.

Customizing the file/folder view
To customize the file/folder view:

1.	 Launch Windows Explorer.
2.	 From the navigation pane, select the location of your data.

3.	 From the toolbar, click the View icon .
4.	 From the View menu, move the slider to select how you want to view the file/folder.

You may also right-click anywhere on the View pane, click View, and select the view type 
that you want.

Arranging your files
To arrange your files:

1.	 Launch Windows Explorer.
2.	 From the Arrange by field, click to display the dropdown list.
3.	 Select your preferred arrangement type.

Sorting your files
To sort your files:

1.	 Launch Windows Explorer.
2.	 Right-click anywhere on the View pane.
3.	 From the menu that appears, select Sort by, then select your preferred sorting type.

Grouping your files
To group your files:

1.	 Launch Windows Explorer.
2.	 Right-click anywhere on the View pane.
3.	 From the menu that appears, select Group by, then select your preferred grouping 

type.
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Adding a new folder
To add a new folder:

1.	 Launch Windows Explorer.
2.	 From the toolbar, click New folder.
3.	 Key in a name for the new folder.

You may also right-click anywhere on the View pane, click New > Folder.

Backing up your files
Setting up a backup
To set up a backup:

1.	 Click  > All Programs > Maintenance > Backup and Restore.
2.	 Click Set up backup. Click Next.
3.	 Select your backup destination. Click Next.
4.	 Select Let Windows choose (recommended) or Let me choose as your backup 

mode. 

Restoring your system settings
The Windows® System Restore feature creates a restore point where the computer’s system 
settings are stored at certain time and date. It allows you to restore or undo changes to your 
computer’s system settings without affecting your personal data.

To restore your system:

1.	 Close all running applications.

2.	 Click  > All Programs > Accessories > System Tools > System Restore.
3.	 Follow the onscreen instructions to complete the process.

If you select Let Windows choose, Windows will not back up your programs, FAT-
formatted files, Recycle Bin files, or temporary files that are 1GB or more.

5.	 Follow the onscreen instructions to finish the process.
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Protecting your computer
Using Windows® 7 Action Center
Windows® 7 Action Center provides you with alert notifications, security information, system 
maintenance information, and the option to automatically troubleshoot and fix some common 
computer problems.

You may customize the notifications. For more details, refer to the previous section 
Customizing icons and notifications in this chapter.

Launching Windows® 7 Action Center
To launch Windows® 7 Action Center:

1.	 To launch Windows 7 Action Center, click the Notification icon , then click Open 
Action Center.

2.	 From Windows 7 Action Center, click the task that you want to do.

Using Windows® Update
Windows Update allows you to check and install the latest updates to enhance the security 
and performance of your computer.

Launching Windows® Update
To launch Windows® Update:

1.	 From the Windows® taskbar, click the Start icon  to launch the Start menu.
2.	 Select All Programs > Windows Update.
3.	 From the Windows Update screen, click the task that you want to do.

Setting up a user account and password
You may create user accounts and passwords for people who will use your computer.

Setting up a user account
To set up a user account:

1.	 From the Windows® taskbar, click  > Getting Started > Add new users.
2.	 Select Manage another account.
3.	 Select Create a new account. 
4.	 Key in the name of the new user.
5.	 Select either Standard user or Administrator as the user type.
6.	 When done, click Create Account. 
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Setting up a user’s password
To set up a user’s password:

1.	 Select the user that you would like to set a password.
2.	 Select Create a password.
3.	 Key in a password and confirm it. Key in your password’s hint.
4.	 When done, click Create password.

Activating the anti-virus software 
Trend Micro Internet Security is pre-installed on your computer. It is a third-party anti-virus 
software protecting your computer from virus. It is purchased separately. You have a 30-day 
trial period after activating it. 

To activate Trend Micro Internet Security:

1.	 Run the Trend Micro Internet Security application.
2.	 Carefully read the license terms. Click Agree & Activate.
3.	 Input your e-mail address and select your location. Click Next. 
4.	 Click Finish to complete the activation.

Getting Windows® Help and Support
Windows® Help and Support provides you with guides and answers in using the applications 
in Windows® 7 platform. 

To launch Windows® Help and Support, click  > Help and Support. 

Ensure that you are connected to the Internet to obtain the latest Windows® online help.
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To remove a USB storage device:

1.	 Click  from the Windows notification area on your 
computer, then click Eject USB2.0 FlashDisk or Eject 
USB3.0 FlashDisk if you are using the USB3.0 flash drive 
or USB3.0-compatible devices.

2.	 When the Safe to Remove Hardware message 
pops up, remove the USB storage device from 
your computer.

Chapter 3
Connecting devices to your computer 

Connecting a USB storage device
This desktop PC provides USB 2.0/1.1 and USB 3.0 ports on both the front and rear panels. 
These USB ports allow you to connect USB devices such as storage devices. 

To connect a USB storage device: 

	 •	 Insert the USB storage device to your computer.

DO NOT remove a USB storage device when data transfer is in progress. Doing so may 
cause data loss or damage the USB storage device.

Front panel Rear panel

E-SATA
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Connecting microphone and speakers
This desktop PC comes with microphone ports and speaker ports on both the front and 
rear panels. The audio I/O ports located on the rear panel allow you to connect 2-channel, 
4-channel, 6-channel, and 8-channel stereo speakers.

Connecting Headphone and Mic

Connecting 2-channel Speakers
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Connecting 4-channel Speakers

Connecting 6-channel Speakers



30 Chapter 3: Connecting devices to your computer

En
gl

is
hEnglish En

gl
is

hEnglish

Connecting 8-channel Speakers
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Connecting multiple external displays
Your desktop PC may come with VGA, HDMI, or DVI ports and allows you to connect multiple 
external displays. 

Setting up multiple displays
When using multiple monitors, you are allowed to set display modes. You can use the 
additional monitor as a duplicate of your main display, or as an extension to enlarge your 
Windows desktop. 

To set up multiple displays: 

1.	 Turn off your computer.
2.	 Connect the two monitors to your computer and connect the power cords to the 

monitors. Refer to Setting up your computer section in Chapter 1 for details on how 
to connect a monitor to your computer. 

When a graphics card is installed in your computer, connect the monitors on the output 
ports of the graphics card.

For some graphic cards, only the monitor that is set to be the primary display has display 
during POST. The dual display function works only under Windows.
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5.	 Select the display mode from the Multiple displays: drop-down list.
	 •	� Duplicate these displays: Select this option to use the additional monitor as a 

duplicate of your main display.
	 •	� Extend these displays: Select this option to use the additional monitor as an 

extension display. This increases your desktop space. 
	 •	� Show desktop only on 1 / 2: Select this option to show desktop only on monitor 

1 or monitor 2.
	 •	 Remove this display: Select this options to remove the selected display.

6.	 Click Apply or OK. Then click Keep Changes on the confirmation message.

3.	 Turn on your computer. 
4.	 Do any of the following to open the Screen Resolution setting screen: 

	 •	� Click  > Control Panel > Appearance and Personalization > Display > 
Change display settings. 

	 •	� Right click anywhere on your Windows desktop. When the pop-up menu appears, 
click Personalize > Display > Change display settings.
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Connecting an HDTV
Connect a High Definition TV (HDTV) to the HDMI port of your computer. 

•	 You need an HDMI cable to connect the HDTV and the computer. The HDMI cable is 
purchased separately.

•	 To get the best display performance, ensure that your HDMI cable is less than 15 
meters. 
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Chapter 4
Using your computer

Proper posture when using your Desktop PC
When using your Desktop PC, maintaining the proper posture is necessary to prevent strain to 
your wrists, hands, and other joints or muscles. This section provides you with tips on avoiding 
physical discomfort and possible injury while using and fully enjoying your Desktop PC.

Eye level to the top of 
the monitor screen

Foot rest 90˚ angles

To maintain the proper posture:

•	 Position your computer chair to make sure that your elbows are at or slightly above the 
keyboard to get a comfortable typing position.

•	 Adjust the height of your chair to make sure that your knees are slightly higher than 
your hips to relax the backs of your thighs. If necessary, use a footrest to raise the level 
of your knees.

•	 Adjust the back of your chair so that the base of your spine is firmly supported and 
angled slightly backward.

•	 Sit upright with your knees, elbows and hips at an approximately 90º angle when you 
are at the PC.

•	 Place the monitor directly in front of you, and turn the top of the monitor screen even 
with your eye level so that your eyes look slightly downward.

•	 Keep the mouse close to the keyboard, and if necessary, use a wrist rest for support to  
reduce the pressure on your wrists while typing.

•	 Use your Desktop PC in a comfortably-lit area, and keep it away from sources of glare 
such as windows and straight sunlight.

•	 Take regular mini-breaks from using your Desktop PC.
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3.	 When finished, right-click the memory card drive icon on the Computer screen, click 
Eject, and then remove the card.

Never remove cards while or immediately after reading, copying, formatting, or deleting 
data on the card or else data loss may occur.

To prevent data loss, use “Safely Remove Hardware and Eject Media” in the Windows 
notification area before removing the memory card.

Using the memory card reader
Digital cameras and other digital imaging devices use memory cards to store digital picture or 
media files. The built-in memory card reader on the front panel of your system allows you to 
read from and write to different memory card drives.

To use the memory card:

1.	 Insert the memory card into the card slot.

2.	 Select a program from the AutoPlay window to access your files. 

•	 If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the 
taskbar, click Computer, and then double-click the memory card icon to access the data 
on it.

•	 Each card slot has its own drive icon which is displayed on the Computer screen.

•	 The memory card reader LED lights up and blinks when data is being read from or 
written to the memory card.

•	 A memory card is keyed so that it fits in only one direction. DO NOT force a card into a 
slot to avoid damaging the card.

•	 You can place media in one or more of the card slots and use each media 
independently. Place only one memory card in a slot at one time.
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Using the optical drive

Inserting an optical disc
To insert an optical disc:
1.	 While your system is on, press the PUSH button.

2.	 Press the eject button below the drive bay cover to open the tray.
3.	 Place the disc to the optical drive with the label side facing up. 
4.	 Push the tray to close it.
5.	 Select a program from the AutoPlay window to access your files. 

Removing an optical disc
To remove an optical disc:

1.	 While the system is on, do either of the following to eject the tray:
•	 Press the eject button below the drive bay cover.

•	 Right-click the CD/DVD drive icon on the Computer screen, and then click Eject.

2.	 Remove the disc from the disc tray.

If AutoPlay is NOT enabled in your computer, click Windows® 7 Start button on the taskbar, 
click Computer, and then double-click the CD/DVD drive icon to access the data on it.
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Using the ASUS ROG U9N Gaming Keyboard
Your CG8580 Essentio Desktop PC comes with the bundled ASUS ROG U9N Gaming 
Keyboard for an optimal gaming experience.
Installing the ASUS ROG U9N Gaming Keyboard

Use the bundled PS/2 to USB adaptor to connect your gaming keyboard to your 
computer’s USB 2.0 port.

1.

Align and insert the wrist pad into the gaming keyboard’s wrist pad slots (A). Using both 
thumbs, push down the wrist pad until it snaps in place (B).

�.

Check the section Package contents for the package contents of the ASUS ROG U9N 
Gaming Keyboard.

Restart your computer. Windows® automatically installs all necessary drivers for your 
keyboard.

�.

A B
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Using the ASUS GX900 Gaming Mouse
Your CG8580 Essentio Desktop PC comes with the bundled ASUS GX900 Gaming Mouse 
for your full-blast game control.

Check the section Package contents for the package contents of the ASUS GX900 
Gaming Mouse.

The ASUS GX900 Gaming Mouse comes with a left button, a right button, a scroll wheel, two 
side buttons, a DPI button, and a specially designed Profile Switch button.

Keys Description Keys Description
1 Left button 7 GX900 logo

2 Right button 8 IE Forward button

3 Scroll wheel 9 IE Backward button

4 DPI switch 10 Mouse feet

5 Profile switch button/Profile indicator* 11 Mouse feet and Twin-Eye Laser sensor

6 LED DPI indicator** 12 Weight base (5 x 4.5g blocks)***

*** To adjust the mouse weight, add or remove the weight blocks.
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*Profile switch LED indications
LED colors Indications

 None Normal Profile

Green Profile 1

Red Profile 2

Orange Profile 3

**DPI switch LED indications
LED colors Indications

2 DPI Level 1

4 DPI Level 2

Launching the program
A specially designed program is pre-installed on your computer, which allows you to set up 
your ASUS GX900 Gaming Mouse to avail all its features.
When you connect ASUS GX900 Gaming Mouse to your computer before starting Windows® 
7 for the first time, the program automatically detected the mouse and can be accessed 
directly. Otherwise, you will have to manually install the setup utility from the bundled Support 
DVD. 
To install the program from Support DVD, place the support DVD into the optical drive and 
follow the onscreen instructions to launch the program.

If Autorun is NOT enabled in your computer, browse the contents of the support DVD to 
locate the GX900.exe file. Double-click the GX900.exe file to launch the program.

Setting your ASUS GX900 Gaming Mouse

Ensure that your gaming mouse is connected to your computer’s USB port. The program 
automatically detects the mouse and displays the main menu.
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Main Menu

Items Description
1 Click each tab to display the selected profile menu.
2 Displays the profile icon to configure profile 1-3 menus.
3 Click to reset the DPI configuration to the previously saved settings.
4 Drag the slider to adjust the DPI value for each level.
5 Click to reset the button settings to the previous settings
6 Click to display the different profile color indicators and their status.
7 Click to load the saved profile to your mouse.
8 Click to save the current profile settings to your hard disk drive.
9 Click to reset all the mouse settings to the factory default settings.

10 Click to save the settings you have made.
11 Click to save the settings you have made and exit the program.

* Each profile provides two DPI levels. Two DPI switch LEDs light up indicating that you are 
using Level 1, and four LEDs light up indicating that you are using Level 2.
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Profile 1 menu

Items Description
1 Click to open the Edit menu and change the profile name and profile icon.
2 Enter the desired profile name.
3 Click to locate the image file you want to use as the profile icon.

4
Select the function for each button/action from the drop down list.

* Refer to the table below for more details.

Functions Description
L-Button Left mouse button function
R-Button Right mouse button function
M-Button Middle mouse button function

IE Backward IE Backward button function. If selected, press the button to go back to 
the previous page.

IE Forward IE Forward button function. If selected, press the button to go to the 
next page.
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Functions Description
Keyboard Press the button to perform a keystroke or keystroke sequence.

Macro Press the button to run a command or series of commands that  you 
can edit via the Edit Macro menu. See Macro menu for details.

Script #1-6 Press the button to run a script that you can edit via the Edit Script 
menu. See Edit Script menu for details.

DPI [+] Press the button to increase the DPI value.
DPI [-] Press the button to decrease the DPI value.
DPI Level 1/2 Press the button to use the DPI Level 1/2.
Profile Switch Profile Switch button function.
Normal Profile Press the button to use the normal profille.
User Profile 1/2/3 Press the button to use the customized profile 1/2/3.

Wheel (left/right)
Press the button to scroll leftward/rightward as a tilt wheel does.

This function only works for Microsoft® Office applications under 
the Windows® 7/Vista operating systems.

Rapid Fire (mouse) Press the button to do a rapid fire in a click-to-attack game, which is 
the same as triple clicking the left mouse button.

Rapid Fire (key) Press the button to do a rapid fire in a game using the spacebar to 
attack, which is the same as pressing the keyboard’s spacebar thrice.

Web Browser Press the button to launch your default web browser.
E-mail Press the button to launch your default e-mail application.
Media Player Press the button to launch your default media player.
Play/Pause

These buttons become playback control buttons in an active media 
player.

Stop
Next Track
Prev Track
Volume Up/Down Press the button to increase/decrease the system volume.
Mute Press the button to turn the volume’s mute mode on/off.
Calculator Press the button to launch the Calculator application.
My Computer Press the button to open My Computer window.
Disabled Select this item to deactivate the mouse’s selected button.
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Edit Macro menu

Items Description
Edit Macro Click to open the Edit Macro menu.

Timing Check this item to record the time between pressing down and 
releasing a button. (Default: 12 milliseconds)

Insert When checked, the new instruction will be inserted before the selected 
instruction. Otherwise, any new instruction will be given the first priority.

Start* Click to start recording the keystrokes and/or mouse actions.
Stop Click to stop recording the keystrokes and/or mouse actions.
Clear Click to clear all saved instructions.
Move up/down Click to move up/down the selected instruction.
Instruction 
cycle time

When Timing is unchecked, all the actions’ delay time will be the value 
you chose from the drop down list.

Loop Sets the macro to run at a click and stop when clicked again.
Fire Sets the macro to run once in one click.

Keeping fire Sets the macro to run when you hold down the button and stop when 
you release the button.

Export Click to save the current macro to your hard disk drive.
Import Click to load a macro from your hard disk drive.
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Edit Script menu

Items Description
Edit Script Click to open the Edit Script menu.

Timing Check this item to record the time between pressing down and 
releasing a button. (Default: 12 milliseconds)

Insert When checked, the new instruction will be inserted before the selected 
instruction. Otherwise, any new instruction will be given the first priority.

Start Click to start recording the keystrokes and/or mouse actions.
Stop Click to stop recording the keystrokes and/or mouse actions.
Clear Click to clear all saved instructions.
Move up/down Click to move up/down the selected instruction.
Instruction 
cycle time

When Timing is unchecked, all the actions’ delay time will be the value 
you chose from the drop down list.

Loop Sets the script to run at a click and stop when clicked again.
Fire Sets the script to run once in one click.

Keeping fire Sets the script to run when you hold down the button and stop when 
you release the button.

Export Click to save the current script to your hard disk drive.
Import Click to load a script from your hard disk drive.
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Chapter 5
Connecting to the Internet

Connecting via a DSL/cable modem
To connect via a DSL/cable modem:

1.	 Set up your DSL/cable modem.

Wired connection
Use an RJ-45 cable to connect your computer to a DSL/cable modem or a local area network 
(LAN).

2.	 Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your 
computer and the other end to a DSL/cable modem.

Refer to the documentation that came with your DSL/cable modem.

3.	 Turn on the DSL/cable modem and your computer.
4.	 Configure the necessary Internet connection settings.

Contact your Internet Service Provider (ISP) for details or assistance in setting up your 
Internet connection.

E-SATA

Modem

RJ-45 cable
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Connecting via a local area network (LAN)
To connect via a LAN:

1.	 Connect one end of an RJ-45 cable to the LAN (RJ-45) port on the rear panel of your 
computer and the other end to your LAN.

2.	 Turn on your computer.
3.	 Configure the necessary Internet connection settings.

Contact your network administrator for details or assistance in setting up your Internet 
connection.

E-SATA

RJ-45 cable LAN
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Wireless connection (on selected models only)
Connect your computer to the Internet through a wireless connection.

To establish a wireless connection, you need to connect to a wireless access point (AP).

E-SATA

Wireless AP

Modem
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To connect to a wireless network:

1.	 Click the network icon  in the notification area to display the available wireless 
networks.

2.	 Select the wireless network that you want to connect to, then click Connect.
3.	 You may need to key in the network security key for a secured wireless network, then 

click OK.
4.	 Wait while your computer is connecting to the wireless network.
5.	 The wireless connection is established successfully. The connection status is displayed 

and the network icon displays the connected  status.

•	 To increase the range and sensitivity of the wireless radio signal, connect the external 
antennas to the antenna connectors on the ASUS WLAN Card.

•	 Place the antennas on the top of your computer for the best wireless performance.

•	 The external antennas are optional items.
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Chapter 6
Using the utilities

AI Suite II
AI Suite II is an all-in-one interface that integrates several ASUS utilities and allows users to 
launch and operate these utilities simultaneously.

Installing AI Suite II
To install AI Suite II on your computer
1.	 Place the support DVD to the optical drive. The Drivers installation tab appears if your 

computer has enabled the Autorun feature.
2.	 Click on the Utilities tab, then click AI Suite II.
3.	 Follow the onscreen instructions to complete installation.

Using AI Suite II
AI Suite II automatically starts when you enter the Windows® operating system (OS). The AI 
Suite II icon appears in the Windows® notification area. Click on the icon to open the AI Suite 
II main menu bar.
Click on each button to select and launch a utility, to monitor the system, to update the 
motherboard BIOS, to display the system information, and to customize the settings of AI Suite II.

•	 •The applications in the Tool menu vary with models. 
•	 The screeshots of AI Suite II in this user manual are for reference only. The actual 

screenshots vary with models.
•	 Refer to the software manual in the support DVD or visit the ASUS website  

at www.asus.com for detailed software configuration.

Software information
Most of the applications in the support DVD have wizards that will conveniently guide you 
through the installation. View the online help or readme file that came with the software 
application for more information.

Click to 
select a 
utility

Click to 
monitor 
sensors 
or CPU 
frequency

Click to 
update the 
motherboard 
BIOS

Click to 
show system 
information

Click to customize  
interface settings

Click to 
display ASUS 
support 
information
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The Tool menu
The Tool menu includes System Level Up, Probe II, Sensor 
Recorder, Dr. Net, USB 3.0 Boost,and Ai Charger+.

System Level Up
System Level Up allows you to overclock the system from within Windows® using the profile 
settings.
To launch System Level up, click Tool > System Level Up on the AI Suite II menu bar.

Assign the hot keys for the System Level Up profile exchange.  You can adjust the hot key 
settings manually. See figure below for details.
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Adjust System Level Up via two methods:

BIOS
In the BIOS Setup program, click Extreme Tweaker > System Level Up, and configure 
the options as needed.

OC Button
Press the OC button on the upper left side corner of the front panel of your desktop.

Probe II
Probe II is a utility that monitors the computer’s vital components, and detects and alerts you 
of any problems. Probe II monitors fan rotations, CPU temperature, and system voltages, 
among others. With this utility, you are assured that your computer is always at a healthy 
operating condition.

Launching Probe II
After installing AI Suite II from the motherboard support DVD, launch Probe II by clicking 
Tool > Probe II on the AI Suite II main menu bar.

Configuring Probe II
Click the Voltage/Temperature/Fan Speed tabs to activate the sensors or to adjust the 
sensor threshold values. The Preference tab allows you to customize the time interval of 
sensor alerts, or change the temperature unit.

Refer to the software manual in the support DVD or visit the ASUS website at
www.asus.com for detailed software configuration.

Loads the default 
threshold values 
for each sensor

Applies changesLoads your saved 
configuration

Saves your 
configuration
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Voltage
The Voltage tab displays the system voltage sensors, including the current and 
threshold values. When a system voltage is less or more than the threshold 
percentage, the sensor sends an alert to the user through the monitor panels, or via a 
pop-up message.

Temperature
The Temperature tab displays the CPU and motherboard temperature sensors, 
including the current and threshold values. When the CPU/MB temperature exceeds 
the threshold temperature, the sensor sends an alert to the user through the monitor 
panels or via a pop-up message.
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Fan Speed
The Fan Speed tab displays the current and threshold rotations (per minute) of the 
CPU, chassis, and power fans. When a fan rotation is less than the threshold rotation, 
the sensor sends an alert to the user through the monitor panels or via a pop-up 
message.

Preference
The Preference tab allows you to enable the pop-up window, set the cycle detection 
interval, and select the temperature unit.
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Alert Log
The Alert Log tab displays all normal and critical events detected by the sensors, 
including the sensor value at the time of the event. Click Clear to empty  the log.

Sensor Recorder
Sensor Recorder monitors the changes in the system voltage, temperature, and fan speed on 
a timeline. The History Record function allows you to record specific time periods for all three 
values.

Launching Sensor Recorder
After installing AI Suite II from the motherboard support DVD, launch Sensor Recorder by 
clicking Tool > Sensor Recorder on the AI Suite II main menu bar.
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Using Sensor Recorder
Click on Voltage/ Temperature/ Fan Speed tabs for the status you want to monitor. Colored 
lines will automatically appear on the diagram to indicate real-time changes to the system 
status.

Using History Record
1.	 Click on the History Record tab and adjust the settings on the left for Type, Date, 

Record Interval, and Record Duration. 
2.	 Colored lines representing the values will be displayed on the graph to indicate 

changes over a given period of time. 
3.	 Click on Recording to record the changes.

Click on Monitor > Sensor on the AI Suite II main menu bar and a highlight of the system 
statuses will appear on the right panel. 
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Ai Charger+
Battery Charging Version 1.1 (BC 1.1), a USB Implementers Forum (USB-IF) certified USB 
charging function, is designed to make USB charging faster than standard USB. Using Ai 
Charger+, a BC 1.1 compliant USB device* will be detected automatically once connected 
to the system and will begin charging at up to three times faster** than standard USB 
devices.

•	 * Check your USB device manufacturer if it fully supports the BC 1.1 feature.

•	 ** The actual charging speed may vary with your USB device’s conditions.

•	 Remove and reconnect your USB device after enabling or disabling Ai Charger+ to 
ensure normal charging function.
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USB 3.0 Boost
ASUS’ exclusive USB 3.0 Boost increases the speed of USB 3.0 devices and provides up-to-
date support for the USB Attached SCSI Protocol (UASP) standard. With USB 3.0 Boost, you 
can accelerate the transfer speed of your USB 3.0 devices with ease.

Launching USB 3.0 Boost
After installing AI Suite II from the motherboard support DVD, launch USB 3.0 Boost by 
clicking Tool > USB 3.0 Boost on the AI Suite II main menu bar.

Configuring USB 3.0 Boost
1.	 Connect a USB 3.0 device to the USB 3.0 port. 
2.	 USB 3.0 Boost automatically detects the type of connected device and switches to 

Turbo mode or UASP mode (if UASP is supported by the connected device).
3.	 You can manually switch the USB 3.0 mode back to Normal mode at any time.

Refer to the software manual in the support DVD or visit the ASUS website at  
www.asus.com for detailed software configuration.
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Sensor
The Sensor panel displays real-time values provided by system sensors monitoring fan 
rotation, CPU temperature, and voltage.

To launch Sensor:

•	 Click Monitor > Sensor on the AI Suite II main menu bar.

CPU Frequency
The CPU Frequency panel displays the current CPU frequency and CPU usage.

To launch CPU frequency:

•	 Click Monitor > CPU Frequency on the AI Suite II main menu bar. 

Sensor panel CPU Frequency panelAs displayed in the right pane (system information area)

The Monitor menu
The Monitor menu includes the Sensor and CPU 
Frequency panels.
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The Update menu
The Update menu allows you to update the 
motherboard BIOS and the boot logo using ASUS 
update utilities.

ASUS Update
ASUS Update provides options for updating the BIOS on your system. You can update the 
BIOS on your system immediately or simply save the BIOS file for later use.

Launching ASUS Update
After installing AI Suite II from the motherboard support DVD, launch ASUS Update by 
clicking Update> ASUS Update on the AI Suite II main menu bar.

Using ASUS Update
Select what you would like to do with the BIOS utility. Click Next and follow the instructions to 
complete your request.

•	 Update BIOS from Internet
Download the latest BIOS utility from the ASUS service website (www.asus.com) and 
follow the procedures to update the BIOS version on your system.

•	 Download BIOS from Internet
Download the latest BIOS utility from the ASUS service website (www.asus.com) and 
save for later use.

•	 Update BIOS from file
Use the BIOS utility to upload a saved BIOS file to update the BIOS version on your 
system.

•	 Save BIOS to file
Back up the current BIOS on your system to a file or USB disk.

There may be risks of a system crash when updating BIOS. Backing up the original BIOS 
utility is recommended before updating.
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USB BIOS Flashback
The USB BIOS Flashback allows user to update the BIOS without entering the BIOS or the 
operating system by using a USB flash disk drive.

•	 This function supports USB flash disks formatted using FAT 32/16 on a 
single partition.

•	 Disable ErP READY in the BIOS before using the USB BIOS Flashback 
feature via the ROG Connect port.

1.	 Download the latest BIOS file from the 
ASUS website.

2.	 Extract and rename the BIOS image file 
to “CG8890.CAP”.

3.	 Copy “CG8890.CAP” to the root 
directory of the USB flash disk drive.

4.	 Turn off the system and connect the 
USB flash drive to the ROG Connect 
port (the white USB 2.0 port) at the rear 
panel of the motherboard.

5.	 Hold the ROG Connect button until the 
LED begins to blink, then release the 
button.

6.	 Wait until the LED stops blinking, 
indicating that the BIOS update process is 
complete.

•	 DO NOT unplug the power while updating the BIOS to prevent system boot 
failure.
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MyLogo2
This MyLogo utility lets you customize the boot logo. The boot logo is the image that appears 
on screen during the Power‑On‑Self-Tests (POST). Personalize your computer from the very 
beginning!

Launching ASUS Update
After installing AI Suite II from the motherboard support DVD, launch MyLogo by clicking 
Update> MyLogo on the AI Suite II main menu bar.

Using MyLogo
Select what you would like to do then click Next and follow the instructions. 

Change the BIOS boot logo of my motherboard

1.	 On the Picture File item, click Browse and choose the desired image for your boot 
logo. Then click Next.
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Audio configurations
The Realtek® audio CODEC provides 7.1-channel audio capability to deliver the ultimate 
audio experience on your computer. The software provides Jack-Detection function, S/PDIF 
Out support, and interrupt capability. The CODEC also includes the Realtek® proprietary 
UAJ® (Universal Audio Jack) technology for all audio ports, eliminating cable connection 
errors and giving users plug and play convenience.
Follow the installation wizard to install the Realtek® Audio Driver from the support DVD that 
came with the motherboard package.

Realtek HD Audio Manager

A.	 Realtek HD Audio Manager for Windows® Vista™ / 7

Control 
settings 
window

Configuration 
option tabs 

Information 
button

Device 
advanced 
settings
Connector 
settings

Analog 
and digital 
connector 
status

Set default 
device button

If the Realtek audio software is correctly installed, you will 
find the Realtek HD Audio Manager icon on the taskbar. 
Double-click on the icon to display the Realtek HD Audio 
Manager.
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Control settings 
window

Configuration 
options 

Information 
button

Exit 
button

Minimize 
button

B.	 Realtek HD Audio Manager for Windows XP

Refer to the software manual in the support DVD or visit the ASUS website at  
www.asus.com for detailed software configuration.

The onboard 8-channel HD audio (High Definition Audio, previously code-named Azalia) 
CODEC enables high-quality 192KHz/24-bit audio output, jack-sensing feature, retasking 
functions and multi-streaming technology that simultaneously sends different audio streams 
to different destinations.

Activating Sound Blaster X-Fi MB 2
After installing Sound Blaster X-Fi MB 2 successfully, you need to activate this utility online 
before first use.

1.	 Double-click Activate on the desktop.

Ensure that you have successfully installed the LAN driver and you are connected to the 
Internet.

Sound Blaster X-Fi MB 2
This application is available only under Windows® Vista and Windows® 7 operating 
systems.

This installation requires that you have the latest version of the Windows Media Player 
installed on your system. Ensure to download and install the latest Windows Media Player 
before installing Sound Blaster X-Fi MB 2.
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Using Sound Blaster X-Fi MB 2

Speaker and Headphone
EAX
Equalizer
Mixer

THX
Adjusting Volume

Restore to Defaults

Mute

2.	 Click Activate to start activation.
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Speaker and Headphone
You can adjust speaker-related or 
headphone-related configurations in 
the Sound Blaster Console.

Environment Audio Extensions (EAX)
After enabling the EAX effects, you 
are allowed to select and add your 
desired environment sounds into the 
music.

Equalizer
You can manually adjust the audio 
frequency with the equalizer and 
customize your presets for later use.
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Mixer
You can manually adjust the audio 
volumes, including Line In, Stereo Mix 
and Microphone, when recording or 
during the playback.

THX
THX is a high-fidelity sound 
technology that allows you to adjust 
the surround sound effect, sub-woofer 
volume, etc.
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After launching the application, the AI Manager icon appears on 
the Windows® taskbar.
Right-click this icon to switch between the quick bar and the 
main window, and to launch the AI Manager either from the 
quick bar or taskbar.

ASUS AI Manager
ASUS AI Manager is a utility which gives you quick and easy access to frequently-used 
applications.

Launching AI Manager
To launch the AI Manager from the Windows® desktop, click Start > All Programs > ASUS > 
AI Manager > AI Manager 1.xx.xx. The AI Manager quick bar appears on the desktop.

AI Manager quick bar
The AI Manager quick bar saves desktop space and allows you to launch ASUS utilities or 
display system information easily. Click any of the Main, My Favorites, Support or Information 
tabs to display menu contents.

Click the Maximize/restore button  to switch between full window and quick bar. Click the 
Minimize button  to keep the AI Manager on the taskbar. Click the Close button  to quit 
the AI Manager.

Click to extend or restore

Main
The Main menu contains three utilities: AI Disk, AI Security, and AI Booting. Click the arrow 
on the Main menu icon to browse through the utilities in the main menu.

Main My Favorites Support Information

Exit button
Switch to main Window
Add to ToolBar
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AI Security
AI Security enables you to set a password to secure your devices, such as USB flash 
disks and CD/DVD disks, from unauthorized access.

To lock a device:
1.	 When using AI Security for the first time, you are asked to set a password. Key in 

a password with a maximum of 20 alphanumeric characters.
2.	 Confirm password. 
3.	 Key in a password hint (recommended).
4.	 Click Ok.

AI Disk
AI Disk allows you to easily clear temporary IE files, IE cookies, IE URLs, IE history, 
or the Recycle Bin. Click the AI Disk icon on the quick bar to display the full AI Disk 
window and select the items you want to clear. Click Apply when done.
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5.	 Select the device you want to lock, then click Apply.
6.	 Key in the password you have set previously, then click Ok. 

To unlock the device:
1.	 Select the locked device, then click Apply. 
2.	 Key in the password you have set previously, then click Ok. 

To change the password:
•	 Click Change Password, then follow the onscreen instructions to change 

password. 
AI Booting
AI Booting allows you to specify boot device priority sequence.

To specify the boot sequence: 

1.	 Select a device, then click the left/right button to specify the boot sequence. 
2.	 Click Apply.



72 Chapter 6: Using the utilities

En
gl

is
hEnglish En

gl
is

hEnglish

My Favorites
My Favorites allows you to add applications you frequently use, saving you from searching 
for the applications throughout your computer.

To add an application:

1.	 Click Add, then locate the application you want to add to My Favorites. 
2.	 Click Open on the file location window. The application is added to My Favorites 

list. 

Right click on the application icon to launch, delete, or rename the selected application. 
You can also double click to launch the selected application.

Support
Click any links on the Support window to go to the ASUS website, technical support website, 
download support website, or contact information. 
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Information
Click the tab on the Information window to see detailed information about your system, 
motherboard, CPU, BIOS, installed device(s), and memory.
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Nero 9	
Nero 9 allows you to create, copy, burn, edit, share, and update different kinds of data.

Installing Nero 9
To install Nero 9:

1.	 Insert the Nero 9 DVD into your optical drive.
2.	 If Autorun is enabled, the main menu appears automatically. 

If Autorun is disabled, double-click the SeupX.exe file from the main directory of your Nero 
9 DVD.

3.	 From the main menu, click Nero 9 Essentials.
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4.	 Select the language you want to use for the Installation Wizard. Click Next.

5.	 Click Next to continue.

6.	 Tick I accept the License Conditions. When done, click Next.
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7.	 Select Typical then click Next.

8.	 Tick Yes, I want to help by sending anonymous application data to Nero then click 
Next.

9.	 When done, click Exit.
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Burning files
To burn files:
1.	 From the main menu, click Data Burning > Add.

2.	 Select the files that you want to burn. When done, click Add.
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3.	 After selecting files that you want to burn, click Burn to burn the files to a disc.

For more details about using Nero 9, refer to the Nero website at www.nero.com
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Recovering your system
Using the Recovery Partition 
The Recovery Partition quickly restores your Desktop PC’s software to its original working 
state. Before using the Recovery Partition, copy your data files (such as Outlook PST files) 
to USB storage devices or to a network drive and make note of any customized configuration 
settings (such as network settings).

About the Recovery Partition
The Recovery Partition is a reserved space on your hard disk drive used to restore the 
operating system, drivers, and utilities installed on your Desktop PC at the factory.

DO NOT delete the partition named RECOVERY. The Recovery Partition is created at the 
factory and cannot be restored if deleted. Take your Desktop PC to an authorized ASUS 
service center if you have problems with the recovery process.

Using the Recovery Partition:

1.	 Press <F9> during bootup.
2.	 Press <Enter> to select Windows Setup [EMS Enabled].
3.	 Select one of the following recovery options.

System Recovery:
This feature allows you to restore the system to factory default settings.
System Image Backup:
This feature allows you to burn system image backups to DVD discs, which you can use 
later to restore the system to its default settings.
System DVD Backup:
This feature allows you to make a backup copy of the support DVD.

4.	 Follow the onscreen instructions to complete the recovery process. 

Visit the ASUS website at www.asus.com for updated drivers and utilities.
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Using the Recovery DVD (on selected models)

Prepare 1~3 blank writable DVDs to create the Recovery DVD.

Remove or disconnect any external hard disks before performing system recovery on your 
Desktop PC. According to Microsoft, you may lose important data due to the risk of setting 
up Windows on the wrong disk drive or formatting the incorrect drive partition.

To use the Recovery DVD:

1. 	 Insert the Recovery DVD into the optical drive. Your Desktop PC needs to be powered 
ON.

2. 	 Restart the Desktop PC and press <F8> on bootup and select the optical drive (may be 
labeled as “CD/DVD”) and press <Enter> to boot from the Recovery DVD.

3.	 Select OK to start.
4.	 Select OK to confirm system recovery.

Restoring will overwrite your hard drive. Back up all your important data before system 
recovery.

5.	 Follow the onscreen instructions to complete the recovery process. 

DO NOT remove the Recovery disc, unless instructed to do so, during the recovery process 
or else your partitions will be unusable.

Visit the ASUS website at www.asus.com for updated drivers and utilities.
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Chapter 7
Troubleshooting

Troubleshooting
This chapter presents some problems you might encounter and the possible solutions. 

? My computer cannot be powered on and the power LED on the front 
panel does not light up
•	 Check if your computer is properly connected.
•	 Check if the wall outlet is functioning.
•	 Check if the Power Supply Unit is switched on. Refer to the section Turning 

your computer ON/OFF in Chapter 1.

? My computer hangs.
•	 Do the following to close the programs that are not responding:

1.	 Simultaneously press <Alt> + <Ctrl> + <Delete> keys on the keyboard, 
then click Start Task Manager.

2.	 Click the Applications tab.
3.	 Select the program that is not responding, then click End Task.

•	 If the keyboard is not responding. Press and hold the Power button on the top 
of your chassis until the computer shuts down. Then press the Power button 
to turn it on. 

? I cannot connect to a wireless network using the ASUS WLAN Card 
(on selected models only)?
•	 Ensure that you enter the correct network security key for the wireless network 

you want to connect to.
•	 Connect the external antennas (optional) to the antenna connectors on the 

ASUS WLAN Card and place the antennas on the top of your computer 
chassis for the best wireless performance.

? The arrow keys on the number key pad are not working. 
	 Check if the Number Lock LED is off. When the Number Lock LED is on, 

the keys on the number key pad are used to input numbers only. Press the 
Number Lock key to turn the LED off if you want to use the arrow keys on the 
number key pad.
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? No display on the monitor.
•	 Check if the monitor is powered on. 
•	 Ensure that your monitor is properly connected to the video output port on 

your computer.
•	 If your computer comes with a discrete graphics card, ensure that you connect 

your monitor to a video output port on the discrete graphics card.
•	 Check if any of the pins on the monitor video connector is bent. If you discover 

bent pins, replace the monitor video connector cable.
•	 Check if your monitor is plugged to a power source properly. 
•	 Refer to the documentation that came with your monitor for more 

troubleshooting information.

? When using multiple monitors, only one monitor has display.
•	 Ensure that the both monitors are powered on. 
•	 During POST, only the monitor connected to the VGA port has display. The 

dual display function works only under Windows. 
•	 When a graphics card is installed on your computer, ensure that you connect 

the monitors to the output port on the graphics card. 
•	 Check if the multiple displays settings are correct. Refer to section 

Connecting multiple external displays in Chapter 3 for details.

? My computer cannot detect my USB storage device.
•	 The first time you connect your USB storage device to your computer, 

Windows automatically installs a driver for it. Wait for a moment and go to My 
Computer to check if the USB storage device is detected. 

•	 Connect your USB storage device to another computer to test if the USB 
storage device is broken or is malfunctioning. 

? I want to restore or undo changes to my computer’s system settings 
without affecting my personal files or data.
	 The Windows® System Restore feature allows you to restore or undo changes 

to your computer’s system settings without affecting your personal data such 
as documents or photos. For more details, refer to the section Restoring your 
system in Chapter 2.
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? The picture on the HDTV is distorted. 
•	 It is caused by the different resolutions of your monitor and your HDTV. Adjust 

the screen resolution to fit your HDTV. To change the screen resolution:
1.	 Do any of the following to open the Screen Resolution setting screen: 		

• Click  > Control Panel > Appearance and Personalization > Display > 
Change display settings. 
• �Right click anywhere on your Windows desktop. When the pop-up menu 

appears, click Personalize > Display > Change display settings.
2.	 Adjust the resolution. Refer to the documentation included with your HDTV 

for the resolution.
3.	 Click Apply or OK. Then click Keep Changes on the confirmation message. 

? My speakers produce no sound. 
•	 Ensure that you connect your speakers to the Line out port (lime) on the front 

panel or the rear panel. 
•	 Check if your speak is connected to an electrical power source and turned on. 
•	 Adjust your speakers’ volume.
•	 Ensure that your computer’s system sounds are not on mute.  

•	 If it is muted, the volume icon is displayed as  . To enable the system  
	 sounds, click  from the Windows notification area, then click  .  

•	 If it is not muted, click  and drag the slider to adjust the volume.
•	 Connect your speakers to another computer to test if the speakers arer 

working properly.

? The DVD drive cannot read a disc.
•	 Check if the disc is placed with the label side facing up.
•	 Check if the disc is centered on the tray, especially for discs with  

non-standard size or shape.
•	 Check if the disc is scratched or damaged. 

? The DVD drive eject button is not responding.

1.	 Click  > Computer.

2.	 Right-click , then click Eject from the menu.
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Power
Problem Possible Cause Action

No power  
(The power 
indicator is off)

Incorrect power voltage

•  �If your computer has a power 
voltage switch, set it to your area’s 
power requirements.

•  �Adjust the voltage settings. Ensure 
that the power cord is unplugged 
from the power outlet.

Your computer is not 
turned on.

Press the power key on the front panel 
to ensure that your computer is turned 
on.

Your computer’s power 
cord is not properly 
connected.

• Ensure that the power cord is 
properly connected.
• Use a different power cord.

PSU (Power supply unit) 
problems Please call our Call Center for repair.

Display
Problem Possible Cause Action

No display 
output after 
turning the 
computer on 
(Black screen)

The signal cable is 
not connected to the 
correct VGA port on your 
computer. 

•  �Connect the signal cable to the 
correct display port (onboard VGA or 
discrete VGA port). 

•  �If you are using a discrete VGA 
card, connect the signal cable to the 
discrete VGA port.

Signal cable problems Try connecting to another monitor.
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LAN
Problem Possible Cause Action

Cannot access 
the Internet

The LAN cable is not 
connected.

Connect the LAN cable to your 
computer.

LAN cable problems

Ensure the LAN LED is on. If not, 
try another LAN cable. If it still does 
not work, contact the ASUS service 
center.

Your computer is not 
properly connected to a 
router or hub.

Ensure that your computer is properly 
connected to a router or hub.

Network settings Contact your Internet Service Provider 
(ISP) for the correct LAN settings.

Problems caused by the 
anti-virus software Close the anti-virus software.

Driver problems Reinstall the LAN driver

Audio
Problem Possible Cause Action

No Audio

Speaker or headphone is 
connected to the wrong 
port.

•  �Refer to your computer’s user 
manual for the correct port.

•  �Disconnect and reconnect the 
speaker to your computer.

Speaker or headphone 
does not work.

Try using another speaker or 
headphone.

The front and back audio 
ports do not work.

Try both the front and back audio 
ports. If one port fails, check if the 
port is set to multi-channel. 

Driver problems Reinstall the audio driver
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System
Problem Possible Cause Action

System speed is 
too slow

Too many programs are 
running. Close some of the programs.

Computer virus attack

•  �Use an anti-virus software to 
scan for viruses and repair your 
computer.

•  �Reinstall the operating system.

The system often 
hangs or freezes.

Hard disk drive failure

•  ��Send the damaged hard disk 
drive to ASUS Service Center for 
servicing.

•  �Replace with a new hard disk drive.

Memory module problems

•  �Replace with compatible memory 
modules.

•  �Remove the extra memory 
modules that you have installed, 
then try again.

There is not enough 
air ventilation for your 
computer.

Move your computer to an area with 
better air flow.

Incompatible software is 
installed.

Reinstall the OS and reinstall 
compatible software.
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CPU
Problem Possible Cause Action

Too noisy right 
after turning on 
the computer.

Your computer is booting 
up.

It is normal. The fan runs on its 
full speed when the computer is 
powering on. The fan slows down 
after entering the OS.

The BIOS settings have 
been changed.

Restore the BIOS to its default 
settings.

Old BIOS version

Update the BIOS to the latest 
version. Visit the ASUS Support 
site at http://support.asus.com to 
download the latest BIOS versions.

Computer is too 
noisy when in use.

The CPU fan has been 
replaced.

Ensure that you are using a 
compatible or ASUS-recommended 
CPU fan.

There is not enough 
air ventilation for the 
computer.

Ensure that your computer is 
working in an area with good air flow.

The system temperature is 
too high.

•  �Update the BIOS. 
•  �If you know how to reinstall the 

motherboard, try to clean the inner 
space of the chassis.

If the problem still persists, refer to your Desktop PC’s warranty card and contact the ASUS 
Service Center. Visit the ASUS Support site at http://support.asus.com for the service 
center information.



ASUS contact information

ASUSTeK COMPUTER INC.
Address			   15 Li-Te Road, Peitou, Taipei, Taiwan 11259
Telephone 			   +886-2-2894-3447
Fax 				   +886-2-2890-7798
E-mail			   info@asus.com.tw
Web site			   www.asus.com.tw

Technical Support
Telephone 			   +86-21-38429911
Online support			   support.asus.com

ASUS COMPUTER INTERNATIONAL (America)
Address			   800 Corporate Way, Fremont, CA 94539, USA 
Telephone 			   +1-510-739-3777
Fax				    +1-510-608-4555
Web site			   usa.asus.com

Technical Support
Telephone 			   +1-812-282-2787
Support fax			   +1-812-284-0883
Online support			   support.asus.com

ASUS COMPUTER GmbH (Germany and Austria)
Address			   Harkort Str. 21-23, D-40880 Ratingen, Germany
Fax				    +49-2102-959911
Web site			   www.asus.de
Online contact			   www.asus.de/sales

Technical Support
Telephone (Component)			   +49-1805-010923*
Telephone (System/Notebook/Eee/LCD)	 +49-1805-010920*
Support Fax			   +49-2102-9599-11
Online support			   support.asus.com

* EUR 0.14/minute from a German fixed landline; EUR 0.42/minute from a mobile 
phone.

Manufacturer: ASUSTeK Computer Inc.
Address: No.150, LI-TE RD., PEITOU, TAIPEI 112, 

TAIWAN
Authorised representative in 
Europe:

ASUS Computer GmbH

Address: HARKORT STR. 21-23, 40880 RATINGEN, 
GERMANY
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